Year End Informational Session
April 2019
Agenda

Procurement Services – Rita Carlo
- PO’s for this year/Requisitions for next year
- Managing Vouchers and Expense Reports
- Vendor Processing Requirements – Including Wire Payments
- P-Card
- Important Reminders for Year End

Human Resource Service Center – Rita Carlo
- Grad Service Stipends
- Change/Terminate Grad Service Stipends
- Grad Non-Service Stipends

Budget Office – Stephen MacPherson
- Reports/Inquiries/Queries
- Reminders – Budget Transfers
Outstanding Requisitions

Review *Manage Requisitions* for orders that have not turned into a purchase order.
Outstanding Purchase Orders

All Purchase Order’s that are still open should be reviewed

• Have the goods been received

• Have all invoices been paid

• Should this PO remain open (Grants/Capital Projects)

• Should the funds be disencumbered

• Use the Change Order Request Form to Close a PO and disencumber the funds
How to Review Open PO’s

PO Balance Report

- BC Reports >> Purchasing >> PO Balances
- Step by Step Guides can be found at [www.bc.edu/financialsystem](http://www.bc.edu/financialsystem)
<table>
<thead>
<tr>
<th>Req #</th>
<th>Req L</th>
<th>PO #</th>
<th>PO Status</th>
<th>Lin #</th>
<th>Sch #</th>
<th>Dst #</th>
<th>Bud Dt</th>
<th>PO Dt</th>
<th>PO Amt</th>
<th>Orig. Amt</th>
<th>Vchr #</th>
<th>Vchr Dt</th>
<th>Line</th>
<th>Descr</th>
<th>Invoice #</th>
<th>Inv Dt</th>
<th>Pymnt Ref</th>
<th>Vchr Amt</th>
<th>Ln Bal Amt</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000106271</td>
<td>1</td>
<td>0000117546</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td></td>
<td>10/29/2018</td>
<td>10/29/2018</td>
<td>7,775.00</td>
<td>7,775.00</td>
<td>ARCTIC INTERNATIONAL</td>
<td>00986626</td>
<td>11/1/2018</td>
<td>Arctic Foreign</td>
<td>11191</td>
<td>10/26/2018</td>
<td>0000262027</td>
<td>7,775.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0000106331</td>
<td>1</td>
<td>0000117511</td>
<td>Complete</td>
<td>1</td>
<td>1</td>
<td>11/1/2018</td>
<td>11/1/2018</td>
<td>4.36</td>
<td>4.36</td>
<td>W B Mason Company</td>
<td>00987188</td>
<td>11/5/2018</td>
<td>Green Line Mfg</td>
<td>6041527</td>
<td>11/2/2018</td>
<td>0000264080</td>
<td>4.36</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>0000106333</td>
<td>1</td>
<td>0000117511</td>
<td>Complete</td>
<td>1</td>
<td>1</td>
<td>11/1/2018</td>
<td>11/1/2018</td>
<td>3.45</td>
<td>3.45</td>
<td>W B Mason Company</td>
<td>00987188</td>
<td>11/5/2018</td>
<td>Value Desktop PC</td>
<td>6041527</td>
<td>11/2/2018</td>
<td>0000264080</td>
<td>3.45</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>0000106349</td>
<td>1</td>
<td>0000117624</td>
<td>Complete</td>
<td>1</td>
<td>1</td>
<td>11/14/2018</td>
<td>11/14/2018</td>
<td>119.97</td>
<td>119.97</td>
<td>W B Mason Company</td>
<td>00990106</td>
<td>11/19/2018</td>
<td>Wire Mesh Stack</td>
<td>6094318</td>
<td>11/16/2018</td>
<td>0000261812</td>
<td>119.97</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>0000106677</td>
<td>1</td>
<td>0000118060</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td>11/29/2018</td>
<td>11/29/2018</td>
<td>49,032.00</td>
<td>49,032.00</td>
<td>JACK MADDEN FORD</td>
<td>00988271</td>
<td>1/7/2019</td>
<td>2018 Ford F-150</td>
<td>29556</td>
<td>11/29/2018</td>
<td>0000266607</td>
<td>49,032.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>0000106678</td>
<td>1</td>
<td>0000118061</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td>11/29/2018</td>
<td>11/29/2018</td>
<td>37,795.00</td>
<td>37,795.00</td>
<td>JACK MADDEN FORD</td>
<td>00988274</td>
<td>1/7/2019</td>
<td>2018 Ford F-150</td>
<td>29557</td>
<td>11/19/2018</td>
<td>0000266432</td>
<td>37,795.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>0000106819</td>
<td>1</td>
<td>0000118258</td>
<td>Complete</td>
<td>1</td>
<td>1</td>
<td>12/6/2018</td>
<td>12/6/2018</td>
<td>8.76</td>
<td>8.76</td>
<td>W B Mason Company</td>
<td>00994427</td>
<td>12/10/2018</td>
<td>White Facial T</td>
<td>6147179</td>
<td>12/7/2018</td>
<td>0000263785</td>
<td>8.76</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>0000107129</td>
<td>1</td>
<td>0000118299</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td>1/7/2019</td>
<td>1/7/2019</td>
<td>58,403.00</td>
<td>58,403.00</td>
<td>JACK MADDEN FORD</td>
<td>00994427</td>
<td>1/7/2019</td>
<td>DINING FORD ICE</td>
<td>58,403.00</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0000107235</td>
<td>1</td>
<td>0000118292</td>
<td>Dispatched</td>
<td>1</td>
<td>1</td>
<td>1/1/2019</td>
<td>1/1/2019</td>
<td>7.40</td>
<td>7.40</td>
<td>STANDARD ELECTRIC SU</td>
<td>Philips Lighting</td>
<td>7.40</td>
<td>7.40</td>
<td>0.00</td>
<td>Philips Lighting</td>
<td>0.00</td>
<td>7.40</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### How to Review Due Dates on PO’s

**BC_PO_BY_DEPT**

<table>
<thead>
<tr>
<th>PO No.</th>
<th>Name</th>
<th>PO Date</th>
<th>Due Date</th>
<th>Status</th>
<th>Budget Status</th>
<th>Buyer</th>
<th>Status</th>
<th>Req Line</th>
<th>Line Description</th>
<th>Category</th>
<th>Recv Reqd</th>
<th>Req ID</th>
<th>Requester</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DELL MARKETING LP</td>
<td>01/14/2019</td>
<td>05/31/2020</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCGRATHK</td>
<td>Active</td>
<td>1</td>
<td>Switched Motorized PDU with Remote Monitoring</td>
<td>CAPITAL IT HARDWARE AND SOFTWARE</td>
<td>N</td>
<td>0000107229</td>
<td>GEEI</td>
</tr>
<tr>
<td>2</td>
<td>RR DONNELLEY</td>
<td>02/06/2019</td>
<td>02/05/2019</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCCLAYCE</td>
<td>Active</td>
<td>1</td>
<td>Urged spring acceptance 2019 kit</td>
<td>PRINT MAJOR PUBLICATIONS&lt;=56K</td>
<td>N</td>
<td>0000107672</td>
<td>FORNARI</td>
</tr>
<tr>
<td>3</td>
<td>ZURI GROUP LLC</td>
<td>01/18/2019</td>
<td>05/31/2021</td>
<td>Dispatched</td>
<td>Valid</td>
<td>FAVREAUP</td>
<td>Active</td>
<td>1</td>
<td>Professional Services</td>
<td>CAPITAL IT CONSULTANT</td>
<td>N</td>
<td>0000107288</td>
<td>GEEI</td>
</tr>
<tr>
<td>4</td>
<td>DELPHIX CORP</td>
<td>01/30/2019</td>
<td>05/31/2022</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCGRATHK</td>
<td>Active</td>
<td>1</td>
<td>Software</td>
<td>CAPITAL IT HARDWARE AND SOFTWARE</td>
<td>N</td>
<td>0000107449</td>
<td>GEEI</td>
</tr>
<tr>
<td>5</td>
<td>DELPHIX CORP</td>
<td>01/30/2019</td>
<td>05/31/2022</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCGRATHK</td>
<td>Active</td>
<td>2</td>
<td>Services</td>
<td>CAPITAL IT HARDWARE AND SOFTWARE</td>
<td>N</td>
<td>0000107449</td>
<td>GEEI</td>
</tr>
<tr>
<td>6</td>
<td>DELPHIX CORP</td>
<td>01/30/2019</td>
<td>05/31/2022</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCGRATHK</td>
<td>Active</td>
<td>3</td>
<td>Support</td>
<td>CAPITAL IT HARDWARE AND SOFTWARE</td>
<td>N</td>
<td>0000107449</td>
<td>GEEI</td>
</tr>
<tr>
<td>7</td>
<td>END2END INC</td>
<td>02/11/2019</td>
<td>05/31/2021</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCGRATHK</td>
<td>Active</td>
<td>1</td>
<td>ARMS Software</td>
<td>CAPITAL IT HARDWARE AND SOFTWARE</td>
<td>N</td>
<td>0000107722</td>
<td>GEEI</td>
</tr>
<tr>
<td>8</td>
<td>END2END INC</td>
<td>02/11/2019</td>
<td>05/31/2021</td>
<td>Dispatched</td>
<td>Valid</td>
<td>MCGRATHK</td>
<td>Active</td>
<td>2</td>
<td>Services</td>
<td>CAPITAL IT HARDWARE AND SOFTWARE</td>
<td>N</td>
<td>0000107722</td>
<td>GEEI</td>
</tr>
<tr>
<td>9</td>
<td>PHYTORION INC</td>
<td>02/18/2019</td>
<td>05/31/2021</td>
<td>Dispatched</td>
<td>Valid</td>
<td>FAVREAUP</td>
<td>Active</td>
<td>1</td>
<td>Professional Services</td>
<td>CAPITAL IT CONSULTANT</td>
<td>N</td>
<td>0000107598</td>
<td>GEEI</td>
</tr>
<tr>
<td>10</td>
<td>PHYTORION INC</td>
<td>02/18/2019</td>
<td>05/31/2021</td>
<td>Dispatched</td>
<td>Valid</td>
<td>FAVREAUP</td>
<td>Active</td>
<td>2</td>
<td>Travel</td>
<td>CAPITAL IT CONSULTANT</td>
<td>N</td>
<td>0000107598</td>
<td>GEEI</td>
</tr>
</tbody>
</table>
Use Activity Summary to view all Vouchers processed against a Purchase Order

<table>
<thead>
<tr>
<th>Details</th>
<th>Receipt</th>
<th>Invoice</th>
<th>Matched</th>
<th>RTV</th>
<th>Description</th>
<th>UOM</th>
<th>Order Qty</th>
<th>Amount Ordered</th>
<th>Amount Matched</th>
<th>Amount Invoiced</th>
<th>Amount Un-invoiced</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CPM GC ELECTRICAL DISTRIBUTION</td>
<td>EA</td>
<td>1.0000</td>
<td>22,357.410</td>
<td>22,057.410</td>
<td>22,057.410</td>
<td>300 000</td>
</tr>
</tbody>
</table>
### Activity Summary

- **Return to Search**
- **Notify**

---

**Unit:** EAGLE  
**PO:** 00001125985  
**Line:** 1  
**Item ID:**

<table>
<thead>
<tr>
<th>Sched Num</th>
<th>AP Unit</th>
<th>Voucher</th>
<th>Line</th>
<th>Quantity Invoiced</th>
<th>Amount Invoiced</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>00992270</td>
<td>1</td>
<td>1.0000</td>
<td>682.40</td>
</tr>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>0089410</td>
<td>1</td>
<td>1.0000</td>
<td>1982.00</td>
</tr>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>00983780</td>
<td>1</td>
<td>1.0000</td>
<td>2251.01</td>
</tr>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>01000867</td>
<td>1</td>
<td>1.0000</td>
<td>4485.00</td>
</tr>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>0089411</td>
<td>1</td>
<td>1.0000</td>
<td>5506.00</td>
</tr>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>0089592</td>
<td>1</td>
<td>1.0000</td>
<td>5638.00</td>
</tr>
</tbody>
</table>

---

**Unit:** EAGLE  
**PO:** 0000112935  
**Line:** 2  
**Item ID:**

<table>
<thead>
<tr>
<th>Sched Num</th>
<th>AP Unit</th>
<th>Voucher</th>
<th>Line</th>
<th>Quantity Invoiced</th>
<th>Amount Invoiced</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EAGLE</td>
<td>0089592</td>
<td>2</td>
<td>1.0000</td>
<td>123.830</td>
</tr>
</tbody>
</table>
Requisitions for next fiscal year

• April 16, 2018 budgets are open for FY2020

• Agreements – can not cross fiscal years

• Enter your Requisition paying careful attention to your “Due Date” and “Budget Date”
  • Due Date should be 05/31/2020
  • Click “OK” to the message – “Warning Date out of range”
  • Budget Date must be 06/01/2019
Requisitions for Next Fiscal Year
Managing Outstanding Voucher’s

All voucher invoices must be ready for Accounts Payable approval, scanned or hand delivered by noon on May 31st.

Helpful Queries:

• **BC_AP_VCHR_NOT_SUBMITTED**
  • This query will show you any voucher you need to Submit for Approval

• **BC_AP_VR_SCAN_INFO_FOR_DEPTS**
  • This query will show any voucher in your area that is pending Accounts Payable approval
Processing in the Correct Fiscal Year

• Prepaid Expenses are paid in FY19 for an event or services related to FY20
  • For FY20 expenses over $4,000 use the prepaid expense account 15440
  • Example: 0xxxx-100-00000-00000-000-00000-15440
  • Cutoff date: 05/31/2019

• Accrued Expenses are expenses for an FY19 event or service paid in FY20
  • Every effort should be made to process invoices by May 31st
  • Amounts over $4,000 should be paid from the accrual account 20020
  • Example: 0xxxx-100-00000-00000-000-00000-20020
  • Cutoff date: 06/18/2019
Managing Outstanding Expense Reports

• All Expense Reports must be ready for Accounts Payable approvals by noon on May 31st.

Queries

• BC_EX_EXPENSES_BY_OPERID
• BC_EX_AGED_EXPENSE_REPORTS

Query Statuses:

- Pending/Not Budget Checked – Must be submitted, budget checked and approved
- Submitted/Error in Budget Check – Expense Report or Budget needs to be corrected, re-budget checked and approved
- Submitted/Not Budget Checked – Must be budget checked and approved
- Submitted/Valid – Must be approved
Vendor Setup Requirements

***BC_AP_VENDOR_NAME1_2_QUERY***

This query is essential when trying to process vouchers for foreign vendors including wire payments

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Name1</th>
<th>Name2</th>
<th>Vendor Status</th>
<th>1099 Withholding</th>
<th>Address Seq No.</th>
<th>Address Description</th>
<th>Address Status</th>
<th>Address 1</th>
<th>Address 2</th>
<th>Address 3</th>
<th>City</th>
<th>State Postal</th>
<th>Country</th>
<th>Classification</th>
<th>Description</th>
<th>Form/Service Start Date</th>
<th>Form/Service Expiration Date</th>
<th>Foreign Vendor Identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>000057207</td>
<td>ALINA ROTARU</td>
<td>Approved</td>
<td>N</td>
<td>1 BOTH-BERLIN</td>
<td>Active</td>
<td>KAMINKEIO G 32-41</td>
<td>MILNIUS LITHUANA</td>
<td>02182</td>
<td>LTU</td>
<td>03/19/2018</td>
<td>FOREIGN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>000057207</td>
<td>ALINA ROTARU</td>
<td>Approved</td>
<td>N</td>
<td>1 BOTH-BERLIN</td>
<td>Active</td>
<td>KAMINKEIO G 32-41</td>
<td>MILNIUS LITHUANA</td>
<td>02182</td>
<td>LTU</td>
<td>03/12/2018</td>
<td>FOREIGN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>000073592</td>
<td>SOCIETY OF THE SACRED HEART</td>
<td>Inactive</td>
<td>N</td>
<td>1 AUCKLAND NEW ZEALAND</td>
<td>Active</td>
<td>WESTPAC QUEEN STREET</td>
<td>AUCKLAND NEW ZEALAND</td>
<td>NZL</td>
<td></td>
<td></td>
<td>FOREIGN- WIRE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
P-Card

• Be proactive by reviewing your p-card balances
  • BC_PCARD_BUDGET_LOW

• Inform cardholders in the department of the p-card balances, important dates and reminders
  • BC_PCARD_HOLDER_EMPL_W_EMAIL

• Review pending orders

• Cancel backordered items or they will be charged to FY20
P-Card

• Transfers into the P-Card account will ensure the cards will be open for use on June 4th
  • Restricted Gifts (Fund 200’s) will not open until 06/01/2019

• Review the list of P-Card holders in BC Custom Menu to inactivate any cardholders who should no longer have access

• Inactivate any cards on expired grants or programs
Important Websites

Office of the Controller:  www.bc.edu/offices/controller
  - Year End Guidelines
Vendor Setup:  www.bc.edu/supplier
  - Tax Forms
  - Foreign Vendor Registration Form
Important Forms:  www.bc.edu/procurement
  - Change Order Request for Purchase Orders
  - Vendor/Student Request Forms
  - Stop Payments/Delete Forms
  - P-Card Support Form
You must create a new “Barcode” for the new budget year 2020.

Fiscal year does not apply to projects/grants.

You must have an existing budget in the new fiscal year to create this barcode.

All chart of account fields are required.

Projects/Grants – enter appropriate project/grant ID.

Copies of barcodes are accepted.
Human Resource Service Center
HR Forms

- Grad Service Stipends
- Change Service Stipends
- Terminating Grad Students
- Grad Non-Service Stipends
Helpful Hints

- Always use the first and last day of the month for Grad Stipends

- Process stipends before the first day of a month in order to be paid for the 16th of that month

- Always check your “Approval Status” to make sure it has been processed by HRSC

- Grad Stipends need approval and if applicable funding and tax specialist approval before it can be paid
HR – Graduate Service Stipends

- BC Custom > Use > Graduate Service Stipends
  - A Student needs to work in order to receive this stipend

Click:

![Add a New Value](image)

Click: [Add]
Remember to change the School Year to 2020. Multiple hires can be processed for an individual, but it is not recommended because the PS HR system cannot handle more than one change on the same day. Manual hires have to be done by HRSC.

Complete form and click:
HR – Change/Terminate Service Stipend

➢ STUDENT/GRAD/PTFCHANGES > USE > STU/GRAD/PTFECR CREATE

Create pay rate changes, job earning distributions and terminations all within this screen.

Enter the Name or Eagle ID of the employee as well as any available field to narrow search.
Change Criteria Search Page

From here you will be able to process an ECR action:

• Earnings Distribution and Extension
• Pay Rate Change
• Termination
For detailed instructions please visit the HR website

http://www.bc.edu/offices/hr/managers.html
HR – Grad Non-Service Stipend

• BC Custom > Use > Grad Non-Service Stipend
• You do not need to work in order to receive this stipend
• Payments are received through Accounts Payable
• Remember to change the Current Year to 2020
• Due to semester swap: Enter Sept through Nov or Jan through April  **Do not use Dec or May**
• The preference is one check issued at the beginning of each semester for the semester
Budget and Actual Spend Reporting Tools

Budget Office
Steve MacPherson
Reports
• ACR (Accounts Comparison Report)
• Setting up a new Run Control ID
• Grants

Inquiries
• Budget Overview Inquiry
• Transactional Detail Inquiry

Queries
• BC_KK_ACR_RANGE_LIM_SLRY
• BC_KK_ACTUALS_TRNS_DTL_LIM_SAL
• BC_GM_BUD_ACCTD_GRANTS
ACR Report
Provides budgeted and expended summary data with balance available.

Navigation: BC Reports > Commitment Control > ACR Report

Step 1: First time in set up a new Run Control by clicking Add a New Value
Step 2: Enter a Run Control ID name that contains no dashes or spaces (underscores are fine)
**Step 3:** Enter Budget Period, Accounting Period and Department

- **Business Unit:** EAGLE (will default)
- **Budget Period:** Enter Budget Year i.e. 2018
- **Account Period:** Enter Period i.e. 4 (September)
- **Fund Code Range:** Select ALL or appropriate Fund code (2xx, 6xx or 9xx)
- **Salary Data:** will default based on your role

**Step 4:** Click **Run**
Step 5: Select Report Format

Features of each ACR Format:

ACR Funds (R004):
- Revenue on separate page from Expense
- Columns: Temp & Perm Xfers, Pre Encumbrance
- Acct Order: Parent first then children
- Funds 100, 2XX, 3XX, 6XX, 900

Associated Budgets (R005):
- Only Fund 111 Assoc Budget
- Total Fund Balance Available (Rev-Exp)
- Separate line for Carry Forwards 63290
- Columns: Temp & Perm Xfers, Pre Encumbrance
- Acct Order: Parent first then children

Department (R013):
- % Available
- Acct Order: Children Accts before Parent
- Columns: Does not show Xfers
- Revenue on separate page from Expense
- Does not show Fund 111 Assoc Budget
This will open up the ACR Report. Note: Once you open the PDF, you can save it by selecting File > Save As > ....
Grant Reports

For instructions on how to run the below reports, please go to OSP’s website: http://www.bc.edu/research/osp/assistdoc.html


**Grant Online ACR** - Provides budgeted and expended summary data with balance available.

**Grant Online TDR** - Provides detail activity. It contains individual transactional detail for the budget transfers, requisitions, purchase orders, vouchers, expense reports, salary encumbrances, salary actuals, and journal entries for standard charges (P-Card, Pitney Bowes, BOC) and allocations (Fringe Benefits, Plant Maintenance, F&A)
The purpose of this inquiry is to provide information about each transaction that makes up a total amount of budgeted, pre-encumbered, encumbered and expensed to an account.

Step by Step Guide: https://www.bc.edu/content/bc/bcres/bcfinancials/reports.html

Navigation: Commitment Control > Review Budget Activities > Budgets Overview

Step 1: First time in set up a new search criteria by clicking Add a New Value

Step 2: Enter an Inquiry Name that contains no dashes or spaces (underscored are fine).

Step 3: Click Add
Budget Overview: Inputs

**Budget Overview Transaction Inquiry / Report Input Key**

**Search**
- Click to run inquiry

**Calendar Type**
- Select "Detail Budget Period"

**Period**
- Enter Budget Period

**Charfield Criteria**
- Enter criteria, at least one CANNOT be a wildcard. A range or % (wildcard) can also be used

**Ledger Group**
- Select ledger group: EXPBUDGETS or REVBUDGETS

**Account Ranges**
- Revenue: 40000 - 49000
- Expenses: 50000 - 76999
- Salaries: 5%
- Expenses: 6%
- Allocations & Transfers: 7%

**Budget Overview Criteria**
- Budget Type: EXPBUDGETS
- Calendar: Detail Budget Period
- From Budget Period: 2013
- To Budget Period: 2013
- Include Adjustment Period(s): Yes
- Include Closing Adjustments: Yes

**Budget Status**
- Open
- Closed
- Hold
Budget Overview: Tools

**Purpose**
This document serves as a map to understand the results of the Budget Overview Inquiry. The inquiry results can be turned into a report with the "Print BOTR" and "Print Exp Pcard Rpt" buttons. The results can also be drilled into transactions, journals, or vouchers.

**Overall Totals:**
- Ledger Totals (3 Rows)
  - Charges: 434,034.00
  - Expense/Transfer: 467,533.44
- Overall Totals: 434,034.00

**Column Order:**
- Column order can be rearranged by dragging column header to new location.

**Print BOTR:**
Produces a PDF transaction report for all chartstrings searched for in the Budget Overview criteria.

**Print Exp Pcard Rpt:**
Produces a transaction report that groups Pcard spend type.

**Drill to Transactions (and to vouchers or journals):**
- Shows Budget Transaction Types
- Shows Budget Details

**Zoomed in Budget Overview Results:**
- Drill to Transactions
- Shows Budget Details

**Navigation:**
Main Menu / Commitment Control / Review Budget Activities / Budgets Overview
### Boston College

#### Budget Overview Transaction Report

<table>
<thead>
<tr>
<th>Account</th>
<th>Budget Period</th>
<th>Department</th>
<th>Fund Code</th>
<th>Fund Source</th>
<th>Program</th>
<th>Function</th>
<th>Property</th>
<th>PCSU</th>
<th>Project</th>
<th>Activity</th>
<th>Resource Type</th>
<th>Application</th>
<th>Processing Date</th>
<th>Voucher ID</th>
<th>Amount</th>
<th>Voucher/ Empl Name/ Header Desc</th>
<th>Line Descr</th>
<th>Ref/ Invoice #</th>
<th>Operator ID</th>
<th>Check #</th>
</tr>
</thead>
<tbody>
<tr>
<td>64002</td>
<td>2018</td>
<td>XXXXX</td>
<td>100</td>
<td>10000</td>
<td>00000</td>
<td>601</td>
<td>00000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$299.69</td>
<td>EDgewater Technology-Ranzal In</td>
<td>Consultant Support for LRFP</td>
<td>62728-xxxxxxx</td>
<td>XXXX</td>
<td>0030000000</td>
</tr>
<tr>
<td>Totals:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$299.69</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Transaction Detail Inquiry

Navigation: BC Report > Commitment Control > TDI LMTD ACCTS

Step 1: Enter Appropriate values
Query: Chartstring Balances

Navigation: Reporting Tools > Query > Query Viewer > BC_KK_ACR_RANGE_LIM_SLRY

You must enter values in the following fields: Budget Period, Account (begins range) and Account (end range). You can use the %, which is a wildcard that will bring back results for all Departments and Funds.

Account Ranges:
Revenue: 40000: 49999
Expenses: 50000: 76999
Salaries: 5%
Expenses: 6%
Allocations & Transfers: 7%

<table>
<thead>
<tr>
<th>Budget Period</th>
<th>VPCode</th>
<th>Dept</th>
<th>Descri</th>
<th>Fund</th>
<th>Fund Source</th>
<th>Program</th>
<th>Descri</th>
<th>Property</th>
<th>Function</th>
<th>Budget Account</th>
<th>Account Descri</th>
<th>Original Budget</th>
<th>Perm Xfers &amp; Adj</th>
<th>Plan Base</th>
<th>Temp Xfers &amp; Adj</th>
<th>Revised Budget</th>
<th>Actuals</th>
<th>Total Encumbered</th>
<th>Budget Bal Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2013</td>
<td>025321</td>
<td>Grad Housing</td>
<td>355</td>
<td>10000</td>
<td>00000</td>
<td>No Program</td>
<td>00000</td>
<td>501</td>
<td>63000</td>
<td>Facility Property Lease</td>
<td>0</td>
<td>0</td>
<td>38251</td>
<td>38251</td>
<td>34190.72</td>
<td>0.00</td>
<td>27060</td>
<td></td>
</tr>
</tbody>
</table>
Query: Actuals Transactions

Navigation: Reporting Tools > Query > Query Viewer > BC_KK_ACTUALS_TRNS_DTL_LIM_SAL

You must enter values in the Budget Period. You can use the %, which is a wildcard that will bring back results for any other field.

<table>
<thead>
<tr>
<th>Trn ID</th>
<th>Trn Date</th>
<th>Accounting Period</th>
<th>Dept</th>
<th>Descr</th>
<th>Fund</th>
<th>Fund Source</th>
<th>Program</th>
<th>Function</th>
<th>Property</th>
<th>Dept</th>
<th>Acct</th>
<th>Document</th>
<th>Descr</th>
<th>Descr 1</th>
<th>Descr 2</th>
<th>Descr 3</th>
<th>Descr 4</th>
<th>Descr 5</th>
<th>Descr 6</th>
<th>Descr 7</th>
<th>Descr 8</th>
<th>Descr 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001345446</td>
<td>07/16/2013</td>
<td>2</td>
<td>025321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>000000</td>
<td>501</td>
<td>000000</td>
<td>63000</td>
<td>63000</td>
<td>Facility Property Leases</td>
<td>CashNet Equipment Deposit</td>
<td>820 GDR HEO OME</td>
<td>0741160713</td>
<td>CashNet Department Deposit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0001345446</td>
<td>07/16/2013</td>
<td>2</td>
<td>025321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>000000</td>
<td>501</td>
<td>000000</td>
<td>63000</td>
<td>63000</td>
<td>Facility Property Leases</td>
<td>CashNet Equipment Deposit</td>
<td>12055.266</td>
<td>0740424535</td>
<td>CashNet Department Deposit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0001345446</td>
<td>07/16/2013</td>
<td>2</td>
<td>025321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>000000</td>
<td>501</td>
<td>000000</td>
<td>63090</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>CashNet Equipment Deposit</td>
<td>18705.646</td>
<td>0740424535</td>
<td>CashNet Department Deposit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0001345446</td>
<td>07/25/2013</td>
<td>2</td>
<td>025321</td>
<td>Grad Housing</td>
<td>365</td>
<td>10000</td>
<td>000000</td>
<td>501</td>
<td>000000</td>
<td>63090</td>
<td>63090</td>
<td>Facility Property Leases</td>
<td>CashNet Equipment Deposit</td>
<td>91543.348</td>
<td>0000425982</td>
<td>Reverse FY1 Local grad housing charge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Download results in: Excel Spreadsheet, CSV Data File, XML File (11 kb)
Query: Grant/Project Balances

Navigation: Reporting Tools > Query > Query Viewer > BC_GM_BUD_ACCTD_GRANTS

You must enter values in the following fields: Department, Fund Code, Fund Source, Program Code, Function, Property, Account and Project/Grant. You can use the '%' which is a wildcard for all fields and just enter the Project ID.

<table>
<thead>
<tr>
<th>Unit</th>
<th>Project Grant</th>
<th>Parent Node</th>
<th>Account</th>
<th>Driver</th>
<th>Function</th>
<th>Original Budget</th>
<th>TEMP REV</th>
<th>REV</th>
<th>Receivable Budget</th>
<th>Actual</th>
<th>Prev Encumbered</th>
<th>Encumbered</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EAGLE 5959959</td>
<td>590100 5903000</td>
<td>Salary Faculty FT 337499</td>
<td>590100 5903000</td>
<td>Salary Faculty FT 337499</td>
<td>590100 5903000</td>
<td>Salary Faculty FT 337499</td>
<td>590100 5903000</td>
<td>Salary Faculty FT 337499</td>
<td>590100 5903000</td>
<td>Salary Faculty FT 337499</td>
<td>590100 5903000</td>
<td>Salary Faculty FT 337499</td>
</tr>
<tr>
<td>2</td>
<td>EAGLE 5959990</td>
<td>520200 5203000</td>
<td>Salary Grad Research Assist</td>
<td>520200 5203000</td>
<td>Salary Grad Research Assist</td>
<td>520200 5203000</td>
<td>Salary Grad Research Assist</td>
<td>520200 5203000</td>
<td>Salary Grad Research Assist</td>
<td>520200 5203000</td>
<td>Salary Grad Research Assist</td>
<td>520200 5203000</td>
<td>Salary Grad Research Assist</td>
</tr>
<tr>
<td>3</td>
<td>EAGLE 5959990</td>
<td>650000 6503000</td>
<td>PCard</td>
<td>650000 6503000</td>
<td>PCard</td>
<td>650000 6503000</td>
<td>PCard</td>
<td>650000 6503000</td>
<td>PCard</td>
<td>650000 6503000</td>
<td>PCard</td>
<td>650000 6503000</td>
<td>PCard</td>
</tr>
<tr>
<td>4</td>
<td>EAGLE 5959990</td>
<td>660000 6603000</td>
<td>9999999999999</td>
<td>660000 6603000</td>
<td>9999999999999</td>
<td>660000 6603000</td>
<td>9999999999999</td>
<td>660000 6603000</td>
<td>9999999999999</td>
<td>660000 6603000</td>
<td>9999999999999</td>
<td>660000 6603000</td>
<td>9999999999999</td>
</tr>
<tr>
<td>5</td>
<td>EAGLE 5959990</td>
<td>670000 6703000</td>
<td>Supplies General</td>
<td>670000 6703000</td>
<td>Supplies General</td>
<td>670000 6703000</td>
<td>Supplies General</td>
<td>670000 6703000</td>
<td>Supplies General</td>
<td>670000 6703000</td>
<td>Supplies General</td>
<td>670000 6703000</td>
<td>Supplies General</td>
</tr>
<tr>
<td>6</td>
<td>EAGLE 5959990</td>
<td>680000 6803000</td>
<td>Travel Domestic</td>
<td>680000 6803000</td>
<td>Travel Domestic</td>
<td>680000 6803000</td>
<td>Travel Domestic</td>
<td>680000 6803000</td>
<td>Travel Domestic</td>
<td>680000 6803000</td>
<td>Travel Domestic</td>
<td>680000 6803000</td>
<td>Travel Domestic</td>
</tr>
<tr>
<td>7</td>
<td>EAGLE 5959990</td>
<td>690000 6903000</td>
<td>Travel Foreign</td>
<td>690000 6903000</td>
<td>Travel Foreign</td>
<td>690000 6903000</td>
<td>Travel Foreign</td>
<td>690000 6903000</td>
<td>Travel Foreign</td>
<td>690000 6903000</td>
<td>Travel Foreign</td>
<td>690000 6903000</td>
<td>Travel Foreign</td>
</tr>
<tr>
<td>8</td>
<td>EAGLE 5959990</td>
<td>700000 7003000</td>
<td>Other Benefits Exempt</td>
<td>700000 7003000</td>
<td>Other Benefits Exempt</td>
<td>700000 7003000</td>
<td>Other Benefits Exempt</td>
<td>700000 7003000</td>
<td>Other Benefits Exempt</td>
<td>700000 7003000</td>
<td>Other Benefits Exempt</td>
<td>700000 7003000</td>
<td>Other Benefits Exempt</td>
</tr>
<tr>
<td>9</td>
<td>EAGLE 5959990</td>
<td>701000 7013000</td>
<td>Other FAC Non</td>
<td>701000 7013000</td>
<td>Other FAC Non</td>
<td>701000 7013000</td>
<td>Other FAC Non</td>
<td>701000 7013000</td>
<td>Other FAC Non</td>
<td>701000 7013000</td>
<td>Other FAC Non</td>
<td>701000 7013000</td>
<td>Other FAC Non</td>
</tr>
</tbody>
</table>

Download results in: Excel Spreadsheet, CSV Text File (6 KB)
Reminders

- Budget Transfers
  - Personalize Budget Lines
  - New Fiscal Year – Change Journal Date to first day of the Fiscal Year

![Image of Budget Transfer interface]

- Queries and Reports
  - Keep your search criteria simple
  - Inquires are timing out – Report this to FMS (fms@bc.edu)
Helpful Hints

• To save your query click *Add to Favorites* located in the far right in the search results.

• To do additional research without losing your results click on *New Window* located in the top right corner below worklist.

• To save your chartstring information to avoid entering each time, click *Save Search Criteria*.
Important Dates to Remember

- Vouchers/Expenses – Must be pending AP approval by 12:00pm on May 31
  - Special Fund Approvals – 10:00am on May 31
- Apple orders – placed by April 29
- Dell orders – placed by April 26
- Ricoh – placed by May 3
- Temporary Payroll Budget Transfers – May 10
- P-Card budget transfers – May 24 by 3:00pm
- Final day for P-Card spending – May 30 by 3:00pm
- Delivery of goods – by May 31
- Shut Down – May 31 – 12:00pm
Thank You